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Larry Stone
Vicki Wassenhove

Larry Stone’s in depth knowledge of computers and the
Windows operating system is a great resource for our club.
Once again he proved to be so as he described some very
practical tips to help our members solve problems.
If a program is an executable file by itself and doesn’t
have any program entry or shortcut icon, how can you make
one? Larry described various alternatives in Windows all of
which are functional.
Go to Run and Search for the executable file on your
computer. When it is discovered, right click on it and create
an icon on your desktop for it. You can also use Windows
explorer to find your executable program file. Then you use
the menu to bring up All Users. You navigate down to the
Start Menu folder. Use your mouse in the other program
window, right click on the .exe file and drag it down to the
Start Menu folder.
How do you change your program icon size on your
desktop or change the name size? Larry said to right click
on an empty space on your desktop, open up the Advanced
tab, then select Icon from the menu. From the icon menu
you can change the icon size, and also the font size for your
shortcuts appearance.
Vicki Wassenhove, our Web designer, has been busy
again making several creative and neat improvements to our
web site. These efforts are in preparation for the Web
design competition at APCUG which begins shortly.
Ñcontinued on next pageÑ
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By analyzing the use of our site
by the Sitemeter.com application,
Vicki was able to determine that
90% of the users prefer a 1024 X
768 resolution for viewing. Up to
this time, our web site has been
designed for the 800 x 600 screen.
Now the Web page is more flexible and is resolution size aware
which makes for less scrolling and
easier viewing as the web site
adapts to the user’s computer automatically.
She has added another wonderful
feature: a site search engine specific
to our QCS website. It searches all
content, the pages, the online newsletters, SIG news information. A
very valuable addition to our web
pages.
Additionally each Special Interest
Group (SIG) will have their own
web page of information and
details.
The completed transformation of
our QCS web site by Vicki hasn’t
been completed, and is a beta test
mode. Be sure to drop by frequently, soon you will see the wonderful changes appear.
Sue Peterson rounded off the evening with an enjoyable collection of
web video humor. One of the more
entertaining vignettes was the stirring Western clip of Cat herders.
Sue played several clips of ingenious pets, their amazing abilities,
and attempts to imitate us.
Our meeting concluded with the
attendance member drawing, which
was not filled again. Next month’s
drawing is up to $40. Some serious
money and a good incentive to
come and see Norm Dunlap’s presentation on Picasa 3.0 You will see
how this fine free photo application
can enhance your computer use and
by being at the meeting in person
you have the chance to walk home
with some change in your pocket!
The QCS thanks our three members
Larry, Vicki and Sue for their fine
presentations. A testimony to the
depth of computer resource and
help among all of our members.

Cyber News
gary.stanley.net/cyber_news.htm

by Gary Stanley

©

2008

Welcome to Cyber News, an ad
free, spam free online magazine
emanating from
gary.stanley.net/studio.htm in
Phoenix, Arizona. In Cyber News
we’ll try to pass along some useful
tips and information about your
computer, the Internet, computer
products, digital photography, other
related topics, and some stuff that’s
not related at all.
There’s a new way to shop on the
Internet. You may have already ordered something from
Amazon.com but now they have
something called "Amazon Window Shop," and it’s pretty cool.
Shop for books, audio books, music, movies, and TV shows. Scroll
back and forth, up and down, and
click on a window for a sample.
Try it out. www.windowshop.com
There’s also a new way to have
dinner and the sky is the limit! How
about having cocktails, appetizers,
and dinner suspended in thin air?
Well, if you’ve got the money and a
little nerve it’s all yours. I’d have to
have lots of drinks to do
Want to know everything about
everything? Well here it is, all on
one page! now.sprint.com/widget
What did we ever do without cell
phones? Technology advances so
fast that we want a new model
every two years, but what do we do
with the old one? How about putting it in your blender. What? Let
me take you to "You Tube" and
watch a guy do that very thing.
Do you have CCleaner on your
computer? If you do are you running it once a week? Don’t say ya,
ya, ya. Do it! You’ll have many less
problems. This is the best utility
that I have ever used. It will get rid
of unused files, clean your registry,
and let you edit start up applications. If you’re uneasy with
computers just do the cleaner. If
you’re more advanced do all three
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functions. If you don’t have it, find
out how to get it and how to use it.
tinyurl.com/5bs7zz. By the way,
it’s free.
How good are you at "eyeballing?" "Well depends on what I’m
looking at," might be your reply.
Most of us may conjure the word to
mean to look at something of
beauty. Well, I’ve got a little
"eyeballing game" for you. This
isn’t hard but will require some
thinking, focus, patience, and spatial awareness, and see how you
score. tinyurl.com/3qynfl
I don’t think I’ll ever get sick of
watching this video. Isn’t it funny
how we like someone who is humble and we pull for them because of
it. tinyurl.com/2ozxt9
Google has a new feature where
you are able to search millions of
historic images.google.com/
hosted/life from Life Magazine,
most of which were never published. Look for people, places,
events, sports, and culture.
I mentioned last month that I established a blog. The original
purpose of it was so that family and
a few friends could follow along on
a trip that we took. I decided to
open it to Cyber News readers for
the purpose of informing you of
items that I write about here that
may come up during the month. An
example may be an announcement
of a critical operating system update or the release of a dangerous
virus. You can click on the BLOG
button on the top left of this page.
Make it a Favorite in your browser
if you wish so you can refer to it
during the month. Don’t click it
now though until you have read the
"Photography Secret" below.
Photography Secret: Sometimes
more is not necessarily better. Case
in point; digital cameras. The paparazzi and sports photographers
carry expensive DSLRs with expensive lenses to capture action. A
professional camera can cost thousands of dollars, but do you need to
spend an arm and a leg for a great
picture? You might if you’re into
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’high profile photography" but today there are point and shoot digital
cameras on the market that take
beautiful pictures at a price that
most anyone can afford. In this
area, technology has made huge advances! As mentioned, in some
circumstances all those extra features on the expensive model are
needed, but most of the time an inexpensive camera will do just fine.
It’s the eye behind the lens that
makes a good picture and not the
cost of the camera.
An interesting experiment: I have
a Nikon D80. The cost of the camera was $1,000, and the cost of the
18-200mm VR lens was $950. With
the external flash I have over
$2,000 invested. Recently I spent
many hours researching before purchasing a small lightweight point
and shoot camera. I bought a Canon
SX110-IS for $250. It’s light weight
and I can carry it on my belt. It’s
simple to operate, has features for
advanced photographers, sports a
large 3 inch LCD, for viewing your
shots, and shoots 9 megapixels. It
will zoom over 7 times farther than
the Nikon, and in most cases I can’t
tell the difference in the final quality of the photo. I took two pictures
of the same scene at the same time
with the same settings, and I wonder if you can tell which one is
which.
You can find the answer on
my.members.cox.net/gary.stanley
/photos.htm So, don’t let the guy
with the "big" camera intimidate
you as you might just end up with a
photo that looks just as good as his.
Isn’t that the bottom line?
One negative about this camera is
that it uses 2 AA batteries and they
don’t last long. Lots of small digital
cameras use this power source and
my advice would be to purchase 4
rechargeable batteries and a
charger. That way you can have a
spare set charged and ready to use
and you won’t have to be buying the
regular type all the time.
I was seriously considering the
Canon G10 which is the next step
up from the one I bought. It’s priced

at $399 and the big difference is its
15 megapixels versus 9. It’s about
the same size as the SX110, but
nobody needs that many pixels unless you’re going to print a picture
the size of your wall. Don’t get
caught up in the megapixel race.
More pixels just means that you can
print a larger picture, and any 5 to
10 megapixel camera will print a
beautiful 8x10 or 11x14 picture and
that’s all 90% of us want to do.
While researching my anticipated
purchase I came across a web site
called "The Luminous Landscape."
When you snoop around this site, it
is obvious this is as professional as
it gets. This guy owns a G10 and
also a $40,000 Hasselblad. (Big
name in professional cameras!) He
did the same thing I did taking a
photo with each camera, then asking several other professionals to
visit his studio for their opinions.
tinyurl.com/5uakgs and see how
far small camera technology has advanced.
Don’t be afraid to look around his
site for more photo tips.
Thanks for reading Cyber News
and viewing my photos!

Broadsides

by Ron Broadhurst, Space
Coast PC Users Group, Inc.,
Florida

These ideas are compiled from
years of accumulations from various magazines, books, on-line sites,
and my own personal experience. I
claim neither originality nor ownership to any of its contents. My only
intent is to share the various “tips,
“tricks”, & “hints” in hopes of helping & maybe enhancing your
computing experiences. They are
all intended for anyone who uses a
PC. It is for beginners as well as advanced users. Enjoy and use as you
will.
Ron Broadhurst
Ñcontinued on next pageÑ
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HOW TO GET RID OF ÒSEND
ERROR REPORT TO MICROSOFT"

Right click My Computer on the
desktop or in the Start menu.
Click Properties.
Click the Advanced tab.
Click the Error Reporting button
at the bottom.
Click Disable error reporting.
You can select the checkbox under
it if you still want to be notified
when errors occur.
Click OK.
Note that you can disable error
reporting for the operating system
only, or for programs only, by
unchecking the appropriate box
under the Enable error reporting
option.
You can also configure error reporting only for specific programs
by clicking the Choose Programs
button.

Express, are permanently positioned for easy access. You can add
your favorite application to this
same convenient location. Open
Windows Explorer and locate the
executable file for the application.
Right-click the file and select Pin
To Start Menu. The application will
now appear in the Start menu. To
remove an application, locate it,
right-click it, and select Unpin
From Start Menu.
Alternatively, you can right-click
the app in the Start menu and click
Unpin From Start Menu.
CHANGE SYSTEM SOUNDS

Through the Control Panel you
can change your system’s program
event sounds. Click Start and Control Panel. If you’re using Category
View, click Sounds, Speech, and
Audio Devices; and Sounds and
Audio Devices. If you are using the
Classic View, click Sounds and
Audio Devices. This loads the
ALPHABETIZE START MENU
Sounds and Audio Devices ProperLISTINGS
ties dialog box. Choose the Sounds
When you install a new program tab. Select the sound you’d like to
on your system, it will often appear change in the Program events box,
at the end of your Start menu. Reor- and then select a new sound from
ganizing files alphabetically in the the Sounds drop-down menu. Or seAll Programs menu does not affect lect a sound you’ve saved to the
how they appear in your start menu. hard drive by using the Browse butIn order to alphabetize your start
ton to navigate to the sound file.
menu, you’ll want to click Start and Change as many sounds as you like.
select All Programs. On any file or Save your changes as a sort of
folder right-click and then select
theme from the Sound Scheme
Sort By Name. Now all of your
drop-down menu above the ProStart menu programs are in alphagram events box. (Select the blank
betical order. You can also sort
line and click Save As.) You can
subfolders in your Start menu the
also choose to disable program
same way.
event sounds. When you’re finished
click OK.
MAKE YOUR QUICK LAUNCH
ICONS BIGGER

Unlock the Toolbar
Right click the QL toolbar
Select the View tab
Select large icons

SAVING E-MAIL MESSAGES

To save e-mail messages highlight the message you want to save,
then click on File -Save As. Select
where you want to save the message and then save it as a .txt file.

PIN AN APPLICATION TO
START MENU

The Windows XP Start menu includes an area where two or more
Microsoft applications, usually Internet Explorer and Outlook
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This article has been obtained from
APCUG with the authorÕs permission
for publication by APCUG member
groups; all other uses require the permission of the author
[ringram728@earthlink.net].

Moving on to
Vista - Part 10
by Neil Stahfest, Librarian,
Tacoma Area PC User Group,
Washington
http://www.tapcug.org,
ncstahfest@msn.com

Most of us who upgrade to Windows Vista from an older version of
Windows encounter compatibility
problems. Vista doesn’t want to recognize some programs as valid or
authorized Windows programs even
though they worked with Windows
XP. Does this mean that you have
to abandon them or upgrade to a
new? Vista version of your favorite
programs?
I wish I could say no but the real
answer is maybe not. Microsoft has
included something called a Program Compatibility Wizard with
Vista. The idea is that, if you have
an older program that doesn’t work
with Vista, you can use this program to automatically make some
modifications to make it compatible
and make it work.
To access the wizard, go to Start,
Control Panel and then click on
Programs. Next, under Programs
and Features, click on? Use an
older program with this version of
Windows. This will start the wizard. Now follow the step-by-step,
on-screen instructions. When you
finish, try to run your program. I’m
told that most programs that
worked with Windows XP will
work after you do this but programs
that worked with older versions of
Windows may not. You shouldn’t
try to use the wizard with disk utility programs, system programs and
anti-virus programs. They usually
won’t work and may actually cause
damage to your computer’s system.
While we’re on the subject of
compatibility and changes, let’s
look at the Start button, or jelly
bean as some call it, in the lower
left corner of your screen. Place
your mouse on the right hand side
of the task bar at the bottom of the
screen. The box next to Hide Inac-
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tive Icons is checked by default. If
you click on the Customize button
to the right you will see why. You’ll
probably see dozens of icons listed
here. Most are turned off. If you
make changes and don’t like the results, click on the Default Settings
button and then click on OK. We’re
almost done with the Notification
Area box.
The bottom half of the box shows
which system icons will show. This
is a personal preference (well, so is
all of this). If you are using Vista’s
Clock gadget you can probably
uncheck the Clock function because
it is redundant. I like to leave Volume checked. Its a convenient place
to turn sound on and off and control
the volume. I also leave Network
checked. It makes it easy to see if
my network connection is working.
The Power option is useful if you
have a laptop computer, otherwise
turn it off.
I think we’ve covered enough for
this month. Are you getting comfortable with Windows Vista? I am.
For those of you still using Windows XP, don’t be in a hurry to
change! Wait for Windows 7 if you
can (coming in 2010).
This article has been obtained from
APCUG with the author's permission
for publication by APCUG member
groups; all other uses require the
permission of the author (see e-mail
address above).

The New, The Best,
and The Worst
by Pim Borman
SW Indiana PC Users Group,
Inc.
November 2008
Cell Phones - The New Computers

Over the years cell phones have
grown from simple portable telephones into multifunction devices
incorporating calendar and data
storage, text messaging, music and
video players, digital cameras, and
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Internet access. They have become
miniature versions of personal computers that incidentally also make
phone calls.
In comparison with computers, mobile phones are at a disadvantage
with respect to screen and speaker
size, slow Internet connections and
high operating cost.
In developing countries, such as
India, China and many parts of Africa and South America that lack
adequate wired telephone connections, cell phones are in widespread
use. Many of the users there don’t
have, and can’t afford, personal
computers. User charges are a small
fraction of those in the United
States and Europe so that cell
phones are rapidly becoming substitutes for personal computers in the
developing nations.
According to an article on the
BBC News Website, sales of smartphones are expected to overtake
those of laptops in the next 12 to 18
months.
Qualcomm is readying a 1 GHz
Snapdragon chipset capable of handling 12 megapixel photos. The
problem in designing advanced
electronics for cell phones is that
they have to operate at very low
wattage because they are carried in
your pocket, without cooling fan,
and the battery is expected to last
days rather than hours. One approach is to use multi-core chips
that can switch off the cores that are
not needed. 3D graphics acceleration chips to support gaming are
also under development. NVidia’s
APX 2500 chip reportedly has
enough 3D graphics capability to
handle Quake 3, a PC game dating
from 1999.
As mobile smartphones are gradually morphing into full-fledged
computers, the hackers can’t be far
behind. According to the BBC Online News, the Emerging Cyber
Threats Report from the Georgia Institute of Technology Security
Center (GTISC) has identified mobile devices as particularly
vulnerable. As they are increasingly
used for financial and payment pur-

poses they become a draw for cyber
criminals.
One obstacle to the miscreants are
the different operating systems used
by various brands of smartphones.
There are Microsoft’s Mobile Windows, Apple’s OS X for the iPhone,
the global open operating system
Symbian used by a large majority
of cell phones, including Nokia,
Samsung and Sony-Ericsson. The
latest addition to the mobile OS’s is
Android, an open standard for mobile devices based on Linux. It has
been developed by the Open Handset Alliance, including Google,
HTC, Intel, Motorola, Qualcomm,
T-Mobile, Sprint Nextel and
NVIDIA. The first handset using
Android, the T-Mobile G-1 was
demonstrated in September 2008
and is expected to go on sale
around now.
It is not surprising that the first virus attacks are reported on the
widely-used Symbian platform.
Network operators report receiving
100,000 virus incidences a day,
50% up from last year. Thus far the
viruses are unsophisticated and the
mobile operators make a special effort to intercept them. They are
likely to become more sophisticated
before long. Users of smartphones
are advised to start using caution
before running attachments from
unknown sources and to check their
monthly bills for problems.
Instant-on Computers?

Do you remember the days when
it would take half a minute or so after you turned on a radio before
you’d hear any sound? The days before transistors when vacuum tubes
did the work and needed time to
heat up? Well, you’re still pretty
spry for your age. And that short
waiting time was nothing compared
to the time it takes your computer
to get ready for work. After all,
when you turn on your PDA there
is no wait, so why can’t computers
be like that?
The answer, of course, is that
computers provide a much broader
Ñ continued on next pageÑ

5

spectrum of services than a simple
PDA, and it takes time to access the
hard drive and retrieve and install
all those drivers for printers, speakers, USB connections, networks,
graphics, and what have you. At
least Windows no longer laboriously counts the bytes in your RAM
as it starts up, a check that could
take up to several minutes all by itself with current multi-gigabyte
memories. Still, there is significant
demand for computers, especially
laptops, that start up (almost) instantly.
There are several ways to achieve
this. One is to keep the computer
turned on in sleep mode, keeping
the current state in active memory
for instant wake-up. That works
fine, but is a little like cheating
since the computer is never fully
shut down. It is especially unattractive for laptops with limited battery
capacity.
Another approach is to provide an
instant-on feature that is limited to
only a few applications, typically
similar to those provided in PDAs.
Dell has incorporated such a feature
for some of its desktop and laptop
computers that gives instant access
to calendars, contacts, the Internet,
and other basic tools with the push
of a special button. Microsoft developed a similar tool that they have
not commercialized yet. According
to InfoWorld (Elizabeth Montalbano, October 17, 2008) Microsoft
is considering such a feature in their
forthcoming Windows 7.
The most attractive solution
would be to store the current state
at shutdown on a solid state flash
memory chip. Until recently, such
memory chips of sufficient capacity, useful life time, and at
affordable cost were not available.
According to PCWorld (November
2008) Intel announced in August a
new Solid State Drive (SSD) chip
that significantly improves the readwrite speeds compared to hard
drives. That in itself would not be
sufficient to provide instant-on
startups. There is no reason I can
see, however, why those chips
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could not be used as well to store
the current state of the computer at
shutdown so it could instantly resume its tasks when turned back on.
Intel rates the chips for five years of
useful life when writing 20 GB of
data per day, and 1.2 million hours
between failure, usually only reserved for the best of hard drives.
© 2008 Willem F.H. Borman. This article may be reproduced in its entirety
only, including this statement, by non-

Click on the link below and watch
the short clip for a quick demonstration.
http://www.google.com/goog411
Reprinted from the November 2008
issue of Fox Tales, newsletter of Fox
Valley PC Association

The Deals Guy
by Bob (The Cheapskate) Click,

profit organizations in their member

Greater Orlando Computer

publications, with mention of the

Users Group

author's name and the Southwestern
Indiana PC Users Group, Inc.

Leave it up to Google to come up with
something like
this!!!

This column is written to make user
group members aware of special offers or freebies I have found or
arranged, and my comments should
not be interpreted to encourage, or
discourage, the purchase of any
products, no matter how enthused I
might sound.

Submitted by Bill Powell Ð

*Lost In Space

FVPCA

A lot is written about cloud computing lately and I wonder how
many of you are as confused about
what that really is as I am. It would
seem that cloud computing has to
do with keeping your data stored on
some distant server or storage service where you hope it is safe. To
me, that’s a new name for an old
concept, uploading it to some distant storage service on the Internet.
On the other hand, in any offsite
concept of storage, things must go
right no matter what the concept is.
In reality, it’s still possible that
things could go terribly wrong.
Read this short article from Information Week magazine about
Nirvanix, whose service turned sour
because of a third-party vendor assisting in providing their service:
www.informationweek.com/new
s/software/hosted/showArticle.jht
l?articleID=210602537&pgno=4
A bad experience like that can
shatter your confidence in Software
as a Service, or Cloud Computing.
The article is “Beyond Online Storage” and the crisis description is
near the end of the article.
Perhaps you could do your own
“Cloud Computing.” For example,

Here’s a number worth putting in
your cell phone, or your home
phone speed dial: 1-800-goog411
(1-800-466-4411).
This is an awesome service from
Google, and it’s free -- great when
you are on the road. Don’t waste
your money on information calls
and don’t waste your time manually
dialing the number. This phone
number will give you, free of
charge, the number of any business
you want and then connect you to it
for FREE! Let’s say I am driving
along in my car and I need to call
the golf course and I don’t know the
number. I hit the speed dial for information that I have programmed
(1-800-466-4411).
The voice at the other end says,
’City & State.’ I say, ’ Garland ,
Texas ’ He says, ’Business, Name
or Type of Service.’ I say, Firewheel Golf Course.’ He says,
’Connecting’ and Firewheel answers
the phone. How great is that? This
is nationwide and it is absolutely
free!
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put some servers in grandma’s
house. She might have a spare bedroom now that the family no longer
lives there. <G> Perhaps there are
ways to do cloud computing yourself, which would make it as secure
as you like, and if something goes
wrong, you should still have the
data, physically. That might also be
an advantage since DNS hijacking
is becoming more prevalent these
days. (I couldn’t resist a tongue-incheek comment!)

ute before I got the same response
as the store gave me and a quick
goodbye, so there went $300. No
more dealings with Best Buy for us,
although perhaps other stores would
also have taken that attitude. I guess
it could be said that you should
check the contents of the box, and
not take anything for granted, when
picking something up yourself.
It was suggested by a friend that I
also call Samsung, which I did; but
they didn’t seem to care either. For
what it’s worth, the metal in the
*DonÕt Trust Anybody!
Samsung microwave’s case was
I’m on my soapbox again this
very thin and flimsy. The installer
month. We purchased a new micro- suggested not replacing it with anwave oven (above the stove type)
other Samsung.
from Best Buy after considerable
shopping because they were the
*Do You Have Memory Probcheapest at the time. Some of you
lems With Your Passwords?
might remember my lawsuit against
Why not give KeePass a try?
Best Buy several years ago. We had Many people try the wrong methwritten them off for shopping, but
ods for managing passwords, such
decided to try them again since this as using the same one for everywas a different store. We bought
thing so it’s easy to remember. All
the unit and when they loaded it
the thief has to do is obtain that one
into my pickup, I checked the box
password, and he can have you
closely before accepting it, and it
hurting. KeePass will help you be
was not damaged. That led me to
better organized, and perhaps you
believe that the microwave oven
will develop better and safer passwas in good condition. Later on, I
word methods. KeePass is FREE,
had a professional installer over to and it’s also open source. Check it
help me with the installation beout at keepass.info/ .
cause of the difficult mounting
That’s it for this month. I’ll have
space over the range. When we
some other new product announceopened the box, the microwave’s
ments on my Web site. Meet me
metal case was badly bent, and the here again next month, if your edidoor alignment was bad. The intor permits.
staller said the unit had obviously
been dropped. Needless to say, the Bob (The Cheapskate) Click
unit would not work.
bobclick@bellsouth.ne
When I tried to take it back to
www.dealsguy.com/.
Best Buy, they said that once I took
possession of the unit, it was my responsibility; and they would not
Hints, Tips, & Rants
replace it, since I had probably
damaged it myself. However, they by Dale Atchison
Tampa Bay Computer Society
sent it to their repair facility for
evaluation. Obviously, Best Buy’s
Most of these links point to the
service facility would not repair the Note:
owners' websites, or to sites that know
damaged unit under the warranty,
they have permission to redistribute
and said it could not even be rethe software. This was easier for me
paired. As a last resort, I tried
than to read the vendors' licenses to
calling Best Buy’s corporate head- see if I could post the actual programs.
The only exceptions are for those
quarters, but to no avail. That
where I recommend a
conversation lasted about one min- programs
program that can no longer be found
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on the Web, or where I recommend an
earlier version of a program over its
currently-distributed version Ñ and I'll
explain why.

MailWasher Troubles

I’ve been using the free version of
MailWasher 2. I know there are
newer versions out there, but they
are rigged to forget all your visual
settings and display a ’beg screen’
every ten starts, until you give up
and buy the program --- I don’t
want that. And, I use the free version of avast! 4.8. Here’s a gotcha I
found last week:
By default, all of avast!’s security
scanners are set to Normal sensitivity; I had set the email scanner to its
High setting, thinking more security
could only be a good thing, right?
Ya know what? Uh-uh. When I receive a large batch of spam
messages in the account I filter with
MailWasher (the free version can
only filter one account per user),
most if not all get marked for
Bounce and Deletion. But when I
click on Process Mail, avast! sees a
rash of nearly-identical emails from
me to various recipients; the program decides my PC has been infected and is now acting as a spam
zombie. It isn’t that much trouble to
click to give each and every
bounced email permission to proceed, but it kinda defeats the
purpose of having an automated
spam filter. So, don’t change the
avast email scanner sensitivity, just
leave it at "Normal".
And while I'm talking about
MailWasher...

If you’re already using it, you
know you can add whole domains
to the Friends or Blacklist by rightclicking anywhere on the message
line, then choosing Add to blacklist
(-), Add to friends list (+), Add the
entire domain to the blacklist, or
Add the entire domain to the friends
list. This is very useful for blocking
those domains that seem to be used
only for spamming, or to whitelist
domains you do business with that
might send you emails from more
Ñcontinued on next pageÑ
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than one address. But beware: if
you blacklist one of the major ISP’s
like AOL, Hotmail, Earthlink,
RoadRunner, Knology, etc., any
email you might receive from
friends who are not yet on your
whitelist will automatically be
marked for Deletion and Bouncing.
So, to be sure you haven’t inadvertently blocked most of your legitimate email, you should periodically
check the blacklist to see if it includes any domains that you didn’t
really mean to block. Here’s how:
In MailWasher, click on Tools »
Blacklist & Friends List. The
Blacklist is on the left. Grab the
vertical scrollbar and drag it to the
bottom of the list. All those addresses that start with an asterisk
are blacklisted domains; all mail
from any sender at any of those domains will be marked for deletion
and bouncing. Read carefully up the
list; if you see any domain(s) from
which you might expect to receive
legitimate email, click once on the
domain to highlight it, then click
Delete. Continue perusing the list
from the bottom up, until you get to
an address that doesn’t start with an
asterisk. Click OK to close the window, then "X" out of MailWasher.
As stated above, I use an older
version of MailWasher so as to
avoid the beg screens.
Recently, I’ve tried out several of
the free utilities suggested by other
contributors to this newsletter. In
the main, I’ve been pleased. But
there have been a few surprises,
too, most noticeably the failure of
my website hit counters after using
IOBit’s Advanced System Care. It
turns out the tracking cookie used
by Statcounter.com is technically
classed as spyware: it keeps up with
your visits to the site that uses the
free hit counter. I see the logic, but
I also want the hit counters to work!
I fixed the problem like this: in
Internet Explorer 7, click on Tools
» Internet Options » Privacy.
First off, make sure the slider is set
to Medium High, then click on
Sites. Look down the list, find an
entry for Statcounter.com, and click
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Remove All. Next, type Statcounter.com in the text box labeled
Address of Website, and click on
Allow. When you’re done removing
then adding sites, click OK » OK
to close Internet Options.
A similar approach should repair
any broken helpers that depend on
cookies to perform their functions.
Till next month...

News From the Help

dia section and uncheck the Play
Animations In Webpages box.
Click Apply, click OK, and restart
IE7 for the change to take effect.
You can also download a browser
add-on to do the task for you. For
example, Flashblock 1.5.6 is an
add-on to Mozilla Firefox that
blocks flash animations but leaves
placeholders, so you can click various animations if you decide you
want to see them. You can download Flashblock from
flashblock.mozdev.org.

Desk

Q. How can I add password

Reprinted with permission from

protection to a file or folder?

Smart Computing.
Visit
www.SmartComputing.com/Gr
oups to learn what
Smart Computing can do for you
and your user group!

Each month, we receive numerous technical support calls and
email messages. Some computer
problems are fairly common, and
we find that many callers struggle
to resolve the same issues. In this
article, we cover some of the most
common or timely tech support
questions and provide our solution
for each of them.
Q. I have a slow Internet connection, and with all the flash
animations on Web sites
these days, Web pages often

A: Technically, you can’t in Windows, although one thing you can
do in Windows XP is compress a
file or folder and then passwordprotect the compressed version.
Right-click the item to be compressed, point to Send To, and
select Compressed (Zipped) Folder.
Double-click the newly created
compressed folder. When the window appears, click File and Add A
Password. Enter a password for the
folder, enter it again to confirm it,
and click OK.
click to PopUp a Larger Image
Setting permissions for
files and folders is an
easy way to prevent
others from accessing
your sensitive data.

take a very long time to load.

Certain applications will also let
you
add password protection. For
tions?
example,
in Microsoft Word 2007,
A: Flash animations are very cool
click
the
Office
button and Save
eye candy, but they can certainly
As.
Within
the
Save
As dialog box,
slow down your Web browsing, esclick
the
Tools
menu
and select
pecially if you have a slower
General
Options.
Finally,
enter a
Internet connection. There are a
password
in
the
Password
To Open
couple of different ways you can go
or
Password
To
Modify
box,
click
about blocking them.
OK,
re-enter
your
password,
click
First, you may be able to do so by
OK, and click Save.
changing your Web browser’s opIf you want to protect files and
tions. In Internet Explorer 7, for
folders
via Windows, you can do
example, all you have to do is click
the
next
best thing(s) to password
Tools, click Internet Options, and
protection:
Encrypt some files or
click the Advanced tab. Scroll
set
up
access
permissions. Note that
down until you reach the Multimenot every option is available on
How can I block flash anima-

QBITS

every Windows OS (operating system); for example, encryption of
files and folders isn’t supported in
Windows Vista Starter, Home Basic, and Home Premium.
To encrypt a file or folder, simply
right-click it and select Properties.
On the General tab, click Advanced, checkmark the Encrypt
Contents To Secure Data box, and
click OK. Click Apply to make the
changes take effect. (You may
have to choose whether to encrypt
only the file or the file and parent
folder and click OK.) This will prevent users logged in under other
accounts from accessing this info.
Setting up access permissions is
nearly as simple. Follow the same
directions as above to reach the
Properties window. Click the Security tab and select one of the entries
under Group Or User Names.
(Click Edit in Vista.) Check any options you want to activate under
Deny and click OK. For example, if
you have folders you don’t want
other users to be able to access or
change, you can deny the Read or
Write options.

quicker. Further, different operating
systems have different requirements; for example, Microsoft
suggests 128MB of RAM is sufficient to run Windows XP but
recommends at least 1GB for Windows Vista.
It may make more sense to ask
this question: “I have a computer
with 512MB of RAM. If I increase
the total amount of RAM to 1GB,
will my computer run faster?” The
answer to that question is "Yes".
Q. My computer is having

Q. My firewall gives me alerts
and messages all the time
about this or that program trying to access the Internet. Do
I have a virus or what?

A: Actually, it sounds like your
firewall is doing its job; it’s blocking programs on your computer
from accessing the Internet and also
preventing certain programs from
accessing your computer via the Internet.

trouble booting; it seems to
want to boot from something

click to PopUp a Larger Image

or somewhere other than my
hard drive. What can I do to
make it boot normally?

A: Your problem is that the boot
order in the BIOS (Basic Input/Output System) needs to be
changed. Basically, your computer
is currently configured to look at
your CD-ROM or floppy drive for
bootable media before looking at
your hard drive. Having the BIOS
configured in this way is necessary
when, for example, you’re first installing your operating system and
Q. I have two computers; one
the computer needs to boot from the
has 512MB of RAM, and one
installation CD or DVD.
has 1GB of RAM. More RAM
To change the BIOS settings, remeans a computer is faster,
boot your computer and continright?
uously press DELETE (or whatever
A: That’s partially true. The fact
your motherboard manufacturer
is, there are many factors that influ- suggests — for example, sometimes
ence how fast a computer operates, you need to press F2) until you
and RAM is one of them.
reach the BIOS screen. (Don’t
But there are other components to worry, you’ll know when you get
consider: The processor, graphics
there!) Note that you most likely
card, and hard drive are three main will be unable to use your mouse in
components that affect a comthe BIOS, so all navigation must be
puter’s performance. A computer
done with the keyboard.
with a 3GHz processor will most
Every BIOS is a little different,
likely be faster than one with a
but you should see something along
2.1GHz processor, for example. A
the lines of Advanced BIOS Feahigh-end graphics card will outper- tures. Move the cursor down to
form a budget card, leading to
highlight Advanced BIOS Features
better performance. A hard drive
(or the equivalent) and press ENthat spins at 4,500rpm will be
TER. Move down to First Boot
slower than one rated at 10,000rpm. Device and press ENTER. Select
You must also consider the level Hard Disk, press ENTER, and press
of maintenance performed on one
F10 to save your changes. When
computer vs. another; the betterprompted with the Save To CMOS
maintained computer may be
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And Exit (Y/N) dialog box, press Y
and then ENTER.

When your firewall is on,
it mediates access to and
from the Internet, but you
can make exceptions for
certain programs manually.
However, there are some programs that you don’t want to be
blocked. Here’s an obvious example: If you block Internet Explorer
from accessing the Internet, you
won’t be able to conduct any Web
browsing from that browser. Many
firewalls, including Windows Firewall, let you configure the firewall
to allow access for certain programs.
Every firewall is going to look a
little different, so ultimately you’ll
have to check your chosen software’s instructions, but an explanation of how to change these settings in Windows Firewall is in
order.
In Vista, click Start, Control
Panel, and Allow A Program
Through Windows Firewall. (In
WinXP, click Start, Control Panel,
Security Center, and Windows Firewall). First, click the General tab
and make sure the Firewall is on; if
it isn’t, click On (Recommended)
and click Apply. Click the Exceptions tab and check the box next to
any programs you want to letthrough the firewall. Click OK to
close the window.
Compiled by Seth Colaner
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Some Interesting
Web Sites

I found these Internet sites while
reading other newsletters and
thought I would share them.
The first two are for crafters. To
get patterns for counted cross-stitch
go to www.alitadesigns.com. Another site for free patterns is
http://www.freepatterns.com/.
These days CD and DVD burning
are of interest to many computer users. Check out
http://www.cdburnerxp.se/ for
CDBurnerXP is a free application
to burn CDs and DVDs, including
Blu-Ray and HD-DVDs. It also includes the feature to burn and create
ISOs, as well as a multilanguage interface. Everyone, even companies,
can use it for free. It does not include adware or similar malicious
components.
Looking for classical music.
Classic Cat is a directory with links
to over 4000 free to download classical performances on the internet,
sorted by composer and work.
http://www.classiccat.net/.
Looking for something ususual.
Check out
http://www.thinkgeek.com/.
While brousing around the site, I
found a t-shirt with musical instrument sounds on the front.
Looking for a little entertainment.
Check out www.thisisjustcool.com
This site is filled with cool things
such as videos that are often of a
humorous content. Pictures include
the ususual like bikes in trees, children holding the sun, and rare
animal photos.
Looking for something to fill the
long winter days. At Make-Stuff,
www.makestuff.com you can learn
a multitude of things. There is a
section for Crafts and Projects. Kid
Stuff is designed for things of interest to kids, such as folding origami.
Cooking is always an interesting
topic. Who isn’t always looking for
new recipes? Formulas and Remedies include home remedies.
Looking for gardening tips, this is
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the place. Check out the Holiday
Access Point,
suggestions. Need Sewing tips, look
no further. The last area I will tell Wireless Keyboard
you about is Recycling. This is not
and Mouse
just about what to put in the recycling bins, but things you can make
Donated to QCS
with the items you ususally throw
away.
The Quad-Cities Computer Society wishes to thank Dale Wells of
Computer Repair Center for doGoogle ROME
nating an access point ,a wireless
earth.google.com/home
keyboard and mouse.
/index.html
Computer Repair Center

Google has creatively added to
their Google Earth site a fully
interactive 3D tour of ancient
Rome. A fascinating stroll
awaits you as you click and
move your way down these
magnificent thoroughfares.

872 Middle Road
Bettendorf IA 52722
PH: 563-359-0042
Fax: 563-359-3411
www.computer-repair-center.com
dale@computer-repair-center.com
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Moving? Send an
address change to:
felspaw@sbcglobal.net
QCS Home Page URL
http://www.qcs.org

Name:
Company:
Address:
City:
State, ZIP+4:
Home Phone:

QCS Meeting
Wednesday
January 14th, 2009
7:00 PM

Work Phone:
E-mail:
Referred by:

Picasa 3
from Google
Membership Level

New Renewal
Full Time Student $20
Individual

$30

Family

$40

with
Norm Dunlap
Digital SIG leader

